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Businesses Dear Test Candidate,
Standardize on

QuickBooks In preparation for the QuickBooks
Certified User exam, we've put together
a set of practice exercises and example
exam questions for you to review. What
you'll find in this packet are:

e Topic areas and objectives for the
exam.

e Practice exercises with image assets.
e Practice exam items.

We've assembled materials from the
QuickBooks software to highlight a few
of the more challenging techniques
covered on the exam. You can work
through these technical guides with

the provided images included in each
exercise. Additionally, we've included the
certification objectives so that you are
aware of the elements that are covered
on the exam. Finally, we've included
practice exam items to give you a feel
for some of the questions covered on the
certification exam.

These materials are meant to help you
familiarize yourself with the areas of the
exam but it is not comprehensive across
all the objectives.

To find additional resources, visit
www.certiport.com/QuickBooks.

Thank you,
Certiport, Inc.
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The following lists the topic areas and percentages
of questions delivered in each topic area:

Number of Questions, Time and Versions
e 50 questions
e 50 minutes
e  Covers QuickBooks Premier/Pro 2009, 2010, and 2011
e  Multiple choice

e  Online proctored exam

After taking the exam, your score is electronically reported and a PDF
of your certificate will be located on your digital transcript. You can
access your transcript once you are registered at www.certiport.com.
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Exam Objectives
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Domain 1.0 Domain
QuickBooks Setup 4.0 Items
A student should know: A student should know:
1.1 What information is required before they set up 4.1 How QuickBooks uses items to perform the
a QuickBooks file necessary accounting entries
1.2 How to start a new company data file in 4.2 The different types of items and when to use
QuickBooks (Easy Step Interview) each type
1.3 How to keep the lists and preferences from an 4.3 How to use items for different types of
old file while removing old transactions scenarios. These include companies that sell:
1.4 How to customize the home page 4.3.1 Products for a specified price
1.5 How to set up lists (customers, vendors, items, 4.3.2 Services for a specified price
etc.). This includes understanding which names 4.3.3 Unique products or services that have
and items should appear on which lists. different prices for each sale

4.3.4 One service or product
Domain 2.0
QuickBooks Utilities

D in 5.
and General Product Knowledge omain 5.0

Sales

A student should know: A student should know:

2.1 How to navigate or move around QuickBooks
(use home page, menus, icon bar, etc.)

5.1 Who should be listed in the Customer Center

5.2 How to navigate and use the Customer Center
2.2 How to back up and restore a data file

2.3 How to determine the release number and how
to update QuickBooks

2.4 How to use QuickBooks in single-user and multi-
user mode

2.5 What versions and editions of QuickBooks are
available for a specific year (desktop version)

2.6 How to password protect QuickBooks

2.7 How and why to use preferences

Domain 3.0
List Management

A student should know:
3.1 How to manage lists (customers, vendors, items,
etc.). List management include:
3.1.1 Adding new entries
3.1.2 Deleting entries
3.1.3 Editing entries
3.1.4 Merging entries
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5.3 How to complete the workflow (from the sale to
making the deposit) for:

5.3.1 Invoicing (A/R)
5.3.2 Sales Receipts (no A/R)

5.4 How QuickBooks uses the Undeposited Funds,
Accounts Receivable, and checking accounts in
the invoicing cycle.

5.5 How and why to record a customer credit
5.6 How and why to create statements
5.7 How to handle bounced (NSF) checks

Domain 6.0
Purchases

A student should know:

6.1 Who should be listed in the Vendor Center
6.2 How to navigate and use the Vendor Center
6.3 The different workflows for making purchases

6.3.1 Entering and paying bills (A/P)

6.3.2 Writing checks

6.3.3 Using a Credit Card

6.3.4 Using a Debit Card

6.4 How to record the transactions in the purchase
workflows

6.5 How and why to record a Vendor credit

6.6 How to complete the inventory workflow (PO to
payment)

6.7 How to set up, collect and pay sales tax

6.6 Bank reconciliation

Domain 7.0
Payroll

A student should know:
7.1 The differences between the Payroll Services
available from QuickBooks

7.2 How to set up Payroll (including employees,
Federal and State taxes and basic Payroll
deductions) using the Payroll Setup Wizard.

7.2.1 How to set up an employee’s earnings
and sick or vacation time

7.2.2 How to track sick or vacation time
(accruing hours and using “banked”
hours)

7.3 How and why to setup Payroll Schedules
7.4 How to run Payroll

7.5 How and why to pay Payroll Liabilities

7.6 How to prepare payroll forms (941, W2) in
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QuickBooks

7.7 Track time and use it for payroll or for invoicing
customers

Domain 8.0 Reports
A student should know:

8.1 Why and how to use the Report Center

8.2 How to customize reports (report modifications,
collapsing subaccounts, etc.)

8.3 The basic question that each report answers
(basic understanding of each report)

8.4 How and why to process multiple reports

8.5 How and why to send reports to Excel
(understand and use the basic and advanced
tab)

8.6 How and why to process multiple reports

8.7 How to memorize reports

Domain 9.0
Basic Accounting

A student should know:
9.1 What the basic financial statements are and
have a basic understanding of what they mean.

9.2 The difference between cash and accrual
reports

9.3 How and why to set a closing date

9.4 How to enter a Journal Entry if asked to do so
by an accountant (they do not need to fully
understand what accounts to debit or credit)

Domain 10.0
Customization/Saving
Time and Shortcuts

A student should know:
10.1 How and why to memorize transactions
(automatically enter)

10.2 How to set up multiple users and what level of
access can be granted or denied

10.3 How and why to create custom fields
(customers, vendors, and employees)

10.4 How to customize an invoice



This section of the study guide will provide guidance
to complete key QuickBooks exercises that could be
included on the certification exam. It will cover the
following QuickBook exercises:

Ivities

How to Add a Payroll Deduction

v
9
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How to Create a Customer Statement

How to Issue a Vendor Credit in QuickBooks

How to Create a Progress Invoice

1.
2
3
4. How to Merge (Combine) Entries on a List
5
6

How to Send a Report from QuickBooks to Excel

balance

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

Intuit QuickBooks Certified User Study Guide



© © ¢ 0 0 0 00 0 0000000000000 000000000 00000000000 0000000000000 000000000000 0000000000000 000000000 O

QuickBooks Exercises
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1. How to Add a Payroll Deduction

In this section, you create payroll items. A payroll item is
anything that affects the amount of a paycheck. It also
includes company expenses (like matched taxes). For
instance, if you pay an employee a salary, it affects the
amount of their paycheck and must be set up as a payroll
item or a deduction for medical insurance. If you deduct
it from an employee’s check, it must be set up as a Payroll
Item.

When you first set up payroll, the QuickBooks Payroll
Setup wizard helps create your company’s payroll items.
However, as your needs change, you might need to add
or edit payroll items. You learn how during this practice
exercise.

Add Payroll Item

1. You decide to offer health insurance at your
company. Add the payroll item. Click the Employees
menu and select Manage Payroll Items >New
Payroll Item.

2. Choose the EZ Setup method and click Next.

3. Select Insurance Benefits as the type and click
Next.

4. QuickBooks loads the Payroll Setup Interview.
Select Health insurance. Click Next.

5. QuickBooks asks how your company pays health
insurance. In this case, the employee pays the full
cost. Select the third option.

6. QuickBooks gives you two more choices. In this case,
health insurance is an after-tax deduction, so click
Payment is deducted after taxes and click Next.
Please note: The only way you can deduct money
before taxes are calculated is if Congress passed a
law that allows you to do this. With certain health
insurance plans, there is a law (Section 125) that
allows health insurance deductions before taxes are
calculated. If you're not sure, always check with an
accountant.

7. Next, enter information about when and who you
pay for the insurance. Click the Payee drop-down list
and select Sergeant Insurance.

8. Enter account number 51233. This account number
appears as the Memo on the Payroll Liability
check QuickBooks creates when you pay Sergeant
Insurance.

Select the setup method you would ke to use to create a new item.
(@ |E2 Setup (uses standard settings; ded for most users)
O Qustom Setup (allows editing of all settings; recoenmended for expert users)

Set up insurance benefits

What kinds of insurance benefits do you provide for your employees? Choose sl that apply:

[ Denkalinsurance

[ ¥ision insurance
Other Insurance

[ Group Term Life

[[] Health Savings Account

[])'5 Corp Medscal

[[] Cther Insurance

E EEE

[[) Medical Care FSA
[[) Dependent Care FSA

Tell us about health insurance

How is Health Insurance paid?
O Company pays for sl of &
© Both the employee and companty pay portions
(& Employee pays for all of it |

1s the employee portion deducted before or after taxes are calculated?

@ Payment is deducted after taxes Help me decide which ooe
© Payment is deducted BEFORE taxes (section 125) tachansn.
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9. Then, enter the Payment frequency for the Add New ®

insurance. In this case, payment is due on the 15th Bok G tha Bepmart schaiie Tor eaitit nsirance

of the month for the prior month’s insurance. Click

Monthly. This step is very important. If you don’t Payee (vender)  [Sergeant Insurance v| Explan
set the frequency, the Liability will not show up in Accourt # 51233

(The number the payee uses to dentify you. Example: $9-9955%0)

the “Pay Scheduled Liabilities” section of the Payroll

Center. This means you may forget to pay it! Pament requency O weeky, on Monday for the peevious weeks labities

Ottty e N _ e
10. Then, click the drop-down list, select 15 and click 000 BRI duy ot oo o g et

Next.

O Quarterly, onthe 1 day of the month for the previous quarter’s kabilties

O anewsalty, on Jarwsary 1 for the previous year's habilties
11. Click Finish.

O 1 don't need a regular payment schedule for this item
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Edit Payroll Item

1. Toedit apayroll item, first open the Payroll Item
List. Click the Employees menu and select Manage
Payroll Items >View/Edit Payroll Item List.

2. Why do you need to edit the payroll item? The
standard employee deduction for Health Insurance
is $50 per week. Did QuickBooks enter the rate for
you? No. For this (and other reasons) we recommend
that you always edit an item after you set it up. Edit payroll item {(Deduction:Health Insurance (taxable))
Double-click Health Insurance.

= Name used in paychecks and payroll

= reports
Enter name for deduction:

\Z
f 9“‘“ { |Medical Insurance )
?\c,?* For example, it you are creating a deduction For employes 401(k) plan,

é N wou may want to call it 401k},
[
A O [ Track Expenses By Job

?‘ Ta track expenses by customer and job, by class, and by service item, select the
checkbox, For more information, click Help,

Next. [ payroll item is inactive
Ta hide this item on the Payroll Ttem list, select the checkbox,

3. QuickBooks calls the deduction Health Insurance
(taxable). Change the name to Medical Insurance.
The name you enter here will appear on paycheck
and reports. So choose something you know your
employees will recognize and understand. Click

4. Now, enter the Liability account for the deduction.
QuickBooks automatically points the deduction
to an account called Payroll Liabilities (because Back Einish [ v ][ cancel
this is money you owe). If you want more detail on
financial statements, create subaccounts for payroll
liabilities. Then, point individual payroll items to the
subaccounts. Point the deduction to a subaccount
called Employee Health Insurance Payable and
click Next.

Edit payroll item {(Deduction:Medical Insurance)

== Agency for employee-paid liability
R

Enter name of agency to

.‘P'Sé which liability is paid: | Jergeant Insurance b/ |

. identifies you to agency:

L% O Liability account ( P — )
\ é?‘ e g, |Payroll Liabilities:Emp. Health Ins Payable v|
b This liability account tracks deductions Fo be paid. You can change this

account ak any time,

=
%?\0‘“ Enter the number that | 51233 |
@‘\

In the next few windows, you will just click next to
get to the end of the Wizard. In most cases, you
don’t need to make any changes.

5. InTax tracking type window, specify how to classify

the deduction on tax forms. QuickBooks enters the [
Back ] L Mext ] Einish

correct information, so click Next.
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6. Inthe Taxes window, enter how the deduction
affects taxes in this window. Again, QuickBooks
enters the information for you, so click Next.

7. Do you base the insurance deduction on a quantity
or hours, or neither? In this case, select Neither and
click Next.

8. Inthe Gross vs. net window, identify how
QuickBooks calculates the deduction based on gross
pay, or based on net pay. Medical Insurance is
not calculated, it’s a flat amount per paycheck. In
this window, you also specify how the deduction
appears on payroll reports, subtracted directly from
gross pay, or subtracted from net pay. QuickBooks
already specified that this is a net pay deduction.
Click Next.

9. Inthe Default Rate and Limit window, enter the
Default rate and limit for the deduction. Default
means you CAN change the information later, if
necessary. Enter the amount of $50 per paycheck.
QuickBooks will use this number when you assign
this Medical Insurance deduction to an employee.
But if necessary, you can change the amount for
each employee (e.g. if an employee wants to add
their spouse or child).

Edit payroll item (Deduction:Medical Insurance)
Taxes

Based on the tax tracking bype you've chosen, QuickBooks automatically selects the taxes
that are almost always affected by this payroll item. In most cases, you don't need to
change the selections you see here,

| Click Default to revert:

| A | to QuickBooks 6

automatic settings,

Default

J | Payroll Item
i i |Federal Unemployment
Federal Withholding
Medicare Company
Medicare Employee
Social Security Company
Social Security Emploves
CA - Withholding

|<

Back ] [ Mext ] Einish Help ] [ Cancel

Edit payroll item (Deduction:Medical Insurance)

————————— Calculate based on quantity

(O aleulate this item based on quantity:

o™

Select this item if you want this payroll item to be calculated based on a quantity that
wou enter manually on paychecks,

oo™
é @\ () Caleulate this itern based on hours

Select this item if you want this payroll item to be calculated based on the Regular

3 %?‘ Pay and Owvertime Pay hours worked,

Include Sick and Yacation hours

Select this item if you want this payroll item to be based on a percent. of Met or
Gross, or a flat amount per paycheck,

[ Back ] [ Mext ] Einish Help ] [ Cancel

Edit payroll item {(Deduction:Medical Insurance)

’p’\' If the rate is a percentage, this item will be calculated based on gross or net pay.

.
& 8

[ Back ] [ Mext ] Einish [ Help ] [ Cancel

The rate you enter here will be the default rate For this item when added to the employes
record, To change the rate or amount For & particular employee, edit their record directly,
QuickBooks will use the number in the emploves record when calculating paychecks,
percent symbol (%) after the number if this is a percentage.

If this item has an upper limit, enter it here, If yvou leave the limit blank on an employee’s
record, this limit will be used, If you leave this limit blank, the limit entered on an
employee’s record will be used, IF you enter a limit both here and on an employves’s
record, the lower of the bwo will be used.,

[ ]

This is an annual limit. (Restart calculations at the beginning of every year.)

11



10. If there is an annual ||m|t, enter it in the second box. Edit payroll item (Deduction:Medical Insurance)

There is no annual limit for the Medical Insurance, Default rate and limit

so leave the box blank. Note: If you do enter a limit,

The rate you enter here will be the default rate for this item when added to the employes
record, To change the rate or amount For a particular employee, edit their record directly,
QuickBooks will use the number in the emploves record when calculating paychecks,
Enter a percent symbol (%) after the number if this is a percentage.

50.00

IF this item has an upper limit, enter it here, If you leave the limit blank on an employee’s
record, this limit will be used, IF you leave this limit blank, the limit entered on an
employee’s record will be used, IF you enter a limit both here and on an employves’s
record, the lower of the bwo will be used.,

specify whether it is an annual limit by checking
this box. In this case there is no limit for the medical
insurance, so make sure the box is unchecked.

11. Click Finish.

[1iThis is an annual limit, {Restart calculations at the beginning of every year.)D

12. When you set up or edit an employee’s record, Edit Employce EE8
you enter this deduction on the Payroll and Information for: Gregg ©. Schneider C =]
compensation info tab below Additions Deductions RS (210l 3 Compenzation Irfo [ omed ]
and Company Contributions. 2 ) [ toe )

Earnings Payrol _-::-
Tbem Name Houlyjanouad Rate | schedue Biweokly ) Eicves B
Reguiar Pay 058 e T 1 1 Disctive
Cvertime Rate =88 = e
Sick Hourly 17.25 w s L

] use time data to create paychecks
Additions, Deductions and Company Contributs

Ttem Name Amount.
Heakh Insurance -12.50

~

[[] Employee i cavered by a qualified pension plan

AL Sl
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2. How to Create a Customer
Statement

Sometimes you want to send statements to customers
to remind them of overdue balances, or to list statement
charges a customer owes.

There are two types of statements in QuickBooks.

The first is called an Open Transaction Statement.
This example shows only open transactions as of the
statement date. This way, a customer knows exactly
how much they owe you but doesn’t see the history of
payments and credits.

The second type of statement is called “Activity Based”.
This shows you the customer’s activity over a period of
time, including payments and credits. In this exercise
you prepare an Open Transaction Statement and a list of
customer’s activity over a period of time.

Customer statements:
Process an open transaction statement

1. From the Home page, click the Statements icon.

2. Inthe Select Statement Options section, select a
type of statement. Select All open transactions
as of Statement Date. This statement shows only
open transactions as of a specific date.

Click One Customer.
Click the drop-down list and select Brian Cook.
Click Preview.

Click the mouse to Zoom in.

N o ovorw

This statement shows only what the customer owes
you. The description shows the original invoice
amount, and the Amount column shows the unpaid
portion of the invoice.

8.  Prepare this type of statement if your customer
only wants to see outstanding balances without the
detail. Click Close.

Create Statements

O statement Period From| 11 1o 2015 (| To [ 12/
@)Mmmadm@

[ tnchude only transactions over [ | days past due date

Select Addrional Options
Template
| Intuk Standard Statement v | [_Customize |

[ show invoice item details on statements
[ print statements by biling address zip code

S o= [#] Prink due dake on transactions
(%) Al Customers Do not create statements:
() Multiple Customers [ with a zero balance
() One Customer [T with & balance less than |
() Customers of Type [[] with no account activity:
) Preferred Send Method [ for inactive customers
[ wiew Selected Customers... | [ Assess Figance Charges... )
(Proven ] (o] (oo ]
T
Fmi Zooma Dt Hely Dose
Bawn K Cock L
w&vl‘m
[ Awountove | amcumEee
| BN
s Date Transacton Ll Baane
31 pory sdbiton
1oy [EHV @308 Do 12250006 Ong Amomd $3.41000 jano sam00
10050013 gﬁ:;se Do 1U140006 Ong Aot 1,100 00 m a11800
15003 [ENV w2080 Den 15250006 Amoent $1434 68 1A 1T
1210013 [ENV #FC & D D2MO0ET Oy Asocest 3595 Fmare . AT
1nsoms mm Do 01142007 g Amosd $1.,604 8. 1604 69 nn
T 0 T TV TV =1
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Customer Statements :

Process a Customer Activity Statement

1. Brian Cook claims he sent a check that wasn’t
applied to his account. Prepare a statement
that shows his activity over a date range. In the
Statement Options section, select Statement Period
From.

2. Enter adate of November 1st, 2015 to November
30th, 2015.

In the Select Customers section, select Brian Cook.
Click the Preview button.

Click the mouse to Zoom In.

o v & ow

An Activity-Based Statement shows all customer
account transactions during the time period. Note: it
only shows Accounts Receivable transactions which
include invoices, payments, statement charges and
credit memos. It does not show Sales Receipts or
cash transactions.

Prepare this type of statement if your customer
wants to see the transactions that make up their
outstanding balance. This statement also shows the
aging periods. Click Close.

7. What if Brian Cook reviews his statement but can’t
find the invoice you sent earlier, so he wants to see
the detail of each invoice. Click the box next to Show
invoice item details on statements.

8. Click Preview.
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Create Statements

Select Statement Options
Satement Date [ 11/30/2015 @]

Select Addrional Options
Template

C@ Statement Period From| 11/11/2015 [@]| To [11/30/2015 @
) All open transackions as of Statement Date

ide only transactions over (=0 |

Select Customers
() Al Customers

[Intuik Standard Statement v | [_Customize J
[:Istmh\.dr.omdamkmmm

[ print statements by biling address zip code
[#] Prink due dake on transactions

Do not create statements:

[] with a zero balance

[] with & balance less than |
D%muw\tm

For inact

[ Assess Finance Charges... ]

Select Statement Options
Satement Date [ 11/30/2015 (@)
@ Statement Period From| 1171172015 ()] T [11/30/2015 (@]
© alloper tors as of Date
Inchude only t t i::
Select Customers
() Al Customers
@) One Customer | Cook, Brian v
O Customers of Type
O Preferred Send Method
[ View Selected Customers... |
(e ]

Select Additional Options
Template

| Inkuik Standard Statement v | [ Customize |

Dmmwmm 2ip code
[#] Prink due dake on transactions

Do not create statements:

[[] with a zero balance:

(7] with 2 balance less than |
Dw&nmuwutm

For inactive customers

Create Statements

Select Statement Options
Satement Date [ 11/30/2015 (@)
@ Statement Period From| 1171172015 ()] T [11/30/2015 (@]
© alloper tors as of Date
Inchude only t t i::
Select Customers
() Al Customers
OWW )
@) One Customer | Cook, Brian v
O Customers of Type
O Preferred Send Method
[ View Selected Customers... |
(e ]

Select Addiional Options
Template
| Inkuik Standard Statement v | [ Customize |

Dmmwmm 2ip code
[#] Prink due dake on transactions
Do not create statements:

[[] with a zero balance:

(7] with 2 balance less than |
Dw&nmuwutm

For inactive customers




9. Clickthe mouse to Zoom In.

10. Now, the statement shows each line item on every
invoice. Use this if your customer needs to see the
invoice detail as a reminder.
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3. How to Issue a Vendor Credit in
QuickBooks

Why would a vendor issue you a credit memo? Maybe
they sent you a bill and over-charged for freight. Or, a
vendor ships some inventory and you discover that some
of it is damaged. So, you return it and receive a “credit
memo”. Remember, vendor credit memos reduce what
you owe the vendor.

What should you do with a vendor credit? You can keep
the credit to use later, apply it to unpaid bills, or request a
refund of your money. In this exercise you record a credit
memo and apply it to a bill.

Enter a credit memo
1. From the Home page, click the Enter Bills icon.
2. Torecord a credit, click the Credit button.

3. Suppose you receive a $1,000 credit from a vendor
that over-billed you for freight. Click the Vendor
drop-down list and select the vendor’s name, Perry
Windows & Doors.

4. Enter the credit memo number, CM-888.
5. Enter the Credit Amount, $1,000.

6. Notice the Items tab and Expenses tab. You should
use the Items tab if a transaction is for a job or for
inventory. (If a credit memo is related to a specific
bill, use whatever tab was used on the bill). In this
case, click the Expenses tab.

Bt Yoot pagm Zoom O e Do
i 117
| 1=
Baun ¥, Cock
45 Charry Lase
Wiakeinkd CA S04
[ woudove | awcurfec
| sme |
™ Date Transaton At Buarce
1I0g00 3 Balwace frward 1736330
24 pory it
1A S00L3 PRAT WS, -la,000 00 734 W
i) (B wa08). D 1725000 LA nmu
— Windios, 110 $200 06 = 15600
— lnrier, 10 @ 47200 = 08
- Eatencr, 3 8 312010 = 34000
— Extenut, | @ $12000 = 12000
— Tox: San Domngs 3 7 ]
nosoms  frr G et e
Eihen
1UR50013  [ENY U075 Dum 17150006 s 1sna
| Sow wacheed mpwcsicton fot detudls o el wedk.
_.wl§:4”-m”
x5, 1 100 5= 19750
T A1 B o0~ 13420
— Deymli$53000
-
— Planbang $X00)
— T e Coemter §1,20 00
-« Tox: San Domngs 3 7.5% = 4951

Dprevious D Bsve Tred Wrtory | lound  § atach

Om @)

Blls... Class 1|
P
»
Saveaiose | [ swveatew [ Cew

‘B Enter Bills
@ previous [P next [ save  FLFind Ty History =] Jounal () aktach

OBl & Credt

Vendor PErry Windows & Doors v Date 12/15/2015 IEI
Ref. No. CM-858]
Credit Amount  1,000.00
Expenses $1,000.00) { Items $0.00

Account Amounk Memo  Customer:Job Bila... Class |
1,000.00 -]
s
(s ) (ot | e | e

e e 00 0000000000000 00 o
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7. Next, click the drop-down list and select Freight &
Delivery as the Account.

8. How does this credit affect the vendor’s balance?
Before you save this credit, let’s look at how much
you owe the vendor. From the Home page, click the
Vendor Center icon.

9. Select Perry’s Windows & Doors from the
list. Before recording this credit, you owe them
$6,705.00

10. Click the Window menu and select Enter Bills to

return to the credit memo.

11. Click Save & Close to save the credit memo.

12. Now look at the balance for Perry in the Vendor

Center. Now you only owe them $5,705.00.

13. Inthe next exercise, you apply the credit against bills

you owe the vendor.

Intuit QuickBooks Certified User Study Guide

Yendors ' Transactions ]

_"‘ VYendor Center: Perry Windows & Doors (All Transact
(D) New Yendor...» New Transactions v (= Printv [

View | Active Vendors

Balance Total
0.00
on Flooring 0.00
ew Plumbing 1,330.00
Madrid, Winnie 0.00
Mason, Elizabeth 0.00
McClain Appliances 0.00
Mendoza Mechanical 0.00
Middlefield Drywall 1,200.00
Miller, Dan 0.00
Pacific Paint Supplies 0.00
4,479.20

6,705.00

Rand, Jenn

Attach

N

Miller, Dan
Pacific Paint Supplies

0.00
0.00
4,479.20

5,705.00

Rand, Jenn 0.00




Apply a credit memo

14 To apply the credit memo against specific bills, first
look at Perry Windows & Doors’ balance in more
detail. Click the Open Balance link on the right side
of the Vendor Center.

15. The Vendor Open Balance report lists each unpaid
bill and credit memo for a vendor. It shows you what
transactions make up a vendor’s balance.

When you enter a credit memo, QuickBooks does
not know which bill to apply it against. You tell
QuickBooks which bill to apply the credit to in the
Pay Bills window. Click the Home page icon to bring
it to the front of the screen.

16. Click the Pay Bills icon.

17.  Use this window to apply vendor credits. Here are
two bills for Perry Windows & Doors. Pay the first
bill. Click the box in the left-most column to select
the bill.

18. QuickBooks shows credit applied to the bill in the
Credits Used column.

Note that QuickBooks applies all $1,000 of the
credits automatically against the first bill. Why did it
do this automatically? Because of a preference that
tells QuickBooks to automatically apply credits. To
set this preference click Edit > Preferences. Then
click the Bills icon and click the Company Preferences
tab. Set the preference in that window.

In this case, suppose you want to only apply $500
credit against the first bill, and the remaining $500
against the second bill.

19. First, select the bill to which QuickBooks has already
applied the credits. Next, click the Set Credits
button.

20. QuickBooks lists the credits. The checkmark means
that QuickBooks applied the credit against bill
number 888.

Click in the Amount to Use field and enter $500.00.
21. Click Done.

22. Click the box for the 2nd bill from Perry’s Windows
& Doors to select it for payment.

Il Vendor Open Balance
Dates | (N ~ | From | (@) 1o

18] sort by [oefouk
KM Rock Castle Construction
Ratlidd Vendor Open Balance
Accrual Basis All Transactions

® Type o __ Date o lum o Memo ¢ DueDate o OpenBalance «
Peiry Windows & Doors

3 Ba 100252015 12472006 1,800.00 160000 4

Ea 1inerMs 121872018 232500 232500

Ba 1202205 oo a7 S0.00 5000

Ba 12042015 01032017 240000 240000

Ba 12mens o1no207 130,00 13000
Credt 12n52M5 M-8 -1,000.00 -1,000.00

Total Perry Windows & Doors 570500 570500
TOTAL 5,705.00 5,705.00

« Pay Bills

T . Manage your butiets expentes uth
Show bils i the Guick Books MasterCand
¢ Leamn More

Totals 23,177.72

Discount & Credt Information for Highlighted B
Vendor

Peny Windows & Doors Terms Net 30 Number of Credits
Bl Ref, No, Sugg. Discount 0.00 Total Credits Avalsble 0.00
Payment
Date Methad ) Account
[12f15{2015 (W) Check ) Orobspad | Chediing -
O tsign check umber Ending Balance 46.169.10
[_Poy Selectednts | [ canced |

€. Discount and Credits
Bill

Yendor Perry Windows & Doors

Ref. No. Amount Due 1,800.00

Date 10f25{2015 Discount Used 0.00

Original Amt, 1,800.00 Credits Used 1.000.00
Amt., To Pay 800,00

| Discount || Credits ]

Totals 1,000.00 1,000,00 0.00 |

l_gone | [ Cancel l [ Help I
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23. QuickBooks automatically applies the remaining
credit against the bill.

24. You are paying with a check that is To be printed.
Note: You could also pay with a credit card (if you set
one up on the chart of accounts).

Click the Pay Selected Bills button.

25. Click Done in the Payment Summary window.

26. Review the effect of the bill payment on the Open
Balance Report. Select Window > Vendor Open
Balance from the menu.

27. The two bills and two credits do not appear on
the report. That’s because you applied the credits
against the bills and then paid the bills.

28. Close the windows.
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« Pay Billz

Manage your burness expenses wth
- the OuickBocks MastarCard
Fiter By | all vendors ~ £ Loaen Mgrs

SortBy |vender -

Disc, Date  Amt, Due  Disc,Used | CredisUsed  Amt, ToPay

Wendor Peny Windows & Doors

Bl Ref, No., . Discount 0.00 Total Credis Avalable 0.00
Paymant
Date Method ) Account

r2jisfzots (@) —] Ot Cheding v

Payment Summary

Payment Details

Payment Date 12/15/2015
Payment Account Checking 2 5
Payment Method  Check

Payments have been successfully recorded for the following 2 of 2 bills:

Date Due Wendor Amount Paid
11/24{2016  |Perry \Windows & Doors 1,300.00
12/18f2016  |Perry Windows & Doors 1,825.00

Tatal 3,125.00

How do I find and change a bill payment?

‘You can print checks now, or print them later From Print Forms on the File menu,

| Pay More Bills i[ Print Checks ][ Done ]

Il Vendor Open Balance

& ro|

X152 PM
1214515

Rock Castle Construction
Vendor Open Balance

Accrual Basis All Transactions
® Type o Date o Hum ¢ _Memo < DueDate - OpenBalance = Amount °
Peny Windows & Doors
» =1 120272015 ol zmT 5000 5000 4
B 1200472015 0032017 240000 240000
B 121172015 7 130.00 130.00
Total Perry Windaws & Doors 258000 __ 256000
TOTAL 258000 _  2.580.00




4. How to Merge (Combine)
Entries on a List

You'll probably come across this real-world scenario.
Someone accidentally enters the same “thing” (name,
account, etc.) on a list by accident. This often happens
because they misspell the entry. Now you have a
problem. The list contains duplicate entries for the same
thing. For example, you already had a vendor named
“Cal Telephone” and someone else entered a check for
“CA Phone”. The same vendor is now represented twice
in the list. This exercise will show you how to fix that error
by merging two entries on the Vendor List (note: this
technique works on other lists too with some exceptions -
mentioned later).

1. From the Home page, click the Vendor Center.

2. Notice there are 2 names (CA Phone and Cal
Telephone).

You want to keep Cal Telephone and merge CA
Phone and all the associated transactions into Cal
Telephone.

Note: if there were no transactions, you could
delete an unwanted name, but that is not the case
here. Let’s merge the two names into one. Think of
Merging as Combining because Merging effectively
combines names on a list. Double-click on CA Phone
(the entry you want to get rid of).

3. Type the correct name, Cal Telephone.
4. Click OK.
5. Click Yes to merge the two names.

Now only the correct name, Cal Telephone, appears
on the list.

QuickBooks also merged the history (all the
transactions) for the two names. That means checks
written to both of the vendors are now included in
the history for Cal Telephone.

Note: There are two restrictions to merging. First,
QuickBooks does not allow you to merge names on
several lists. For example, you cannot merge entries
on the Customer Message List.

A

C

Vendor Center. CA Phone (All Transactions)

[ New Vendor...w 1)) New Transactions » (o Printv 4

|vendors ITrW!

mmvm % v

Cheung Limked

Bank of Anvycity 0.00
Bayshore CalOl Service 0.00
Bayshore Water 0.00
Bruce's Office Machines

— This name is already being used. Would you lie to merge them?

e =
Me. M. e e
FrstName | ML | Fax |
LastName | | ax. phooe |

Ak, Contact |

E-mal

Ce

Prirt on Check a5

Cal Gas & Electric
Addresses
Billad From Address Shipped From Mddress
Cal Gas & Elsctric

P.0. Box 5037
Vet A oae2

(e ]

Bayshore CalOl Service 0.00
Bayshore Water 0.00
Bruce's Office Machines 0.00
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The second restriction only applies to lists with a Type
column, like the Chart of Accounts. You can only merge
Name

names of the same type. For example, you can merge
. +Construction Income
one expense account with another expense account, oDesign Income

but can’t merge an expense account with an income e« Equipmeant Rental Income
account. #Labor Income
eLess Discounts given
o Materiaks Income
+Subcontracted Labor Income
*Reimbursement Income
+Mieage Income
oParmikt Reimbursament Income
+Reimbursed Freight & Delivery
+Cost of Goods Sold
+Job Expenses
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5. How to Progress Invoice

Sometimes your company might have a job that takes
months or even years to finish. Do you wait until the job is
finished to start invoicing? In most cases you want to be
paid for the work you've completed. This process is called
Progress Invoicing. Essentially, you invoice in increments
based on an estimate. In this exercise, assume you have
already created an estimate for $3,114 for your customer
Kristy Abercrombie.

1. First, make sure to turn the progress invoice feature
on. To do this click Edit > Preferences and click
the Jobs & Estimates icon. Click the Company
Preferences tab. In this window select “yes” below
“Do you create estimates? And select “yes” below
“Do you do progress invoicing?”

2. Prepare aninvoice based on the Kristy
Abercrombie estimate. Click the Create Invoices
icon.

3. Click the Customer:Job drop-down arrow and select
the Kristy Abercrombie job.

4. QuickBooks opens the Available Estimates window.

Select an estimate to convert it to an invoice. Select
estimate number 606.

5. Click OK.

6. QuickBooks opens the Create Progress Invoice
Based on Estimate window.

Progress Invoicing means you invoice against the
estimate in increments until the job or contract

is complete. If you choose the first option, Create
invoice for the entire estimate, QuickBooks copies

all line items and quantities from the estimate to
the invoice. The second choice lets you invoice a
percentage of the estimate. The third choice lets you
specify the items and quantities to transfer from the
estimate to the invoice. In this case, select the third
option.

7. Click OK.

8. Decide which items and quantities to invoice. Click
the Show Quantity and Rate and the Show
Percentage boxes.

9. The first four columns show information from the
Estimate. The next three columns show anything
already invoiced for the job. The last six columns
show what you want to charge the customer on this
invoice.

To transfer an item to the invoice, enter a Quantity,
Amount, or Percentage. In this case, enter 3
quantities. For the first line item, enter 5 for Framing.

B create Invoices

[ TET— mpeen) |
DR R=Tor g Wb e cromibie, Kristy | ~| E i
Invo Select an estimate to invoice 1100

ose I—

| T s

oy 4 -
5647 Cyf :
ITEM .

Oustmerl I Ta |5,me |(? ?5%) 0.00

Total  0.00

[[] To be printed Add TmefCosts... | = Aoply Credts Payments Applied 0.00
%:::mw Customer Tax Code Im fij Cocs e 00
Memo

() Create invoice for the entire estimate (100%).
O Create invosce for a percentage of the entire estimate,

Customer - Tax [San Tomas ~](7.75%) 0.00
Total  0.00

[[] To be printed Add TmefCosts... |  foply Credts Payments Applied 0.00
| Balance Due 0.00

Custorer Tax Code qu v

e =]

For each item below, Wylhewuuy rate, smount or % of the estimate
st tohave onthe e ([(one ]

mm) =)

Total trf Lanes)

Mote: thy Th and oll be a3 Althensgh wth & 2er0 amount.
displary on sereen, they can be sot not to peink from the Jobs and Estimates Preferences.

Specity Invoice Amounts for ltems on Estimate

Frogress Invoice for: b b
For each e below, specfy the quantty, rate, smount or % of the estimate.
Invokce.

Total (w] taxes)

Wt i Th = =
display on screen, they can be set not o print from the Jobs and Estimates Preferences.
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10. For the second line item, enter that you installed 5 B Croate Invoices
D previous B et

Frames. B - & dspeing Qrstory ] Jounal [ Progress

.Cummn:pb rwﬂm_
11. For the third line item, enter that you removed 5 b ty:Remode v | [ v [Rock Castle Invoice. 1| ¢
Frames. Invoice EI E'
12. Click OK.

13. QuickBooks copies the selected items to the invoice.

To print the invoice later, select the To be printed

et 30 e [01/14/2016 |E||
RATE A Tax |

checkbox. Framing Fraing labor 5 55.00 [27... Non A
listion labor Is 35.00 |17... |Non
14. Click Save & Close. Removal |[Remavallsbor [ pad b
c\umml VI Tax [San Tomas  w](7.75%) .00
Hessage
Total  77...
%m:m [ Add TmefCosts... | [ Apply Credts... | Payments Appled 0.00
To be e-maided T 1 Balance Due 779.00
5] Alow ondno Customer Tax Code | Tax v:
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6. How to Send a Report from
QuickBooks to Excel

QuickBooks has powerful reporting capabilities. However,
there are some report functions and modifications that
QuickBooks cannot perform. For example, if a QuickBooks
report does not total a column or row, you can’t add the
calculation yourself. You also can’t rename column or row
headings. There is a way around this, however. You can
send a report from QuickBooks to Microsoft Excel to take
advantage of the unique features Excel offers.

In this lesson you export a report to Excel, learn how to
make calculations and modifications to get more from
your data, and learn how to outline and filter report data
to improve report presentation and find information
faster.

Export report to Excel

1. To begin, open the report you want to export to
Excel. For example, to export the Balance Sheet,
from the Home page click Reports > Company &
Financial > Balance Sheet Standard.

2. Click the Export button to send the report to Excel.

3. You have three choices for the export. You can
send the report to a comma separated values file.
Do this if you do not have Microsoft Excel on your
computer. Second, you can send the report to a new
Excel workbook. Or third, you can send the report to
an existing workbook. This creates a new sheet in
specific Excel workbook.

4. Choose to send the Balance Sheet to a new Excel
workbook.

5. Click the Export button.

6. QuickBooks automatically starts Microsoft Excel and
copies the report to a new spreadsheet. Any changes
made here do NOT affect your QuickBooks data. The
labels are text fields that you can change.

M
124518

Accrual Basis

Rock Castle Construction
Balance Sheet
As of December 15, 2015

- Dec 15,15 *
ASSETS

Curvent Assets
Cliecking Savings
Checking L3 4526910 4
Petty Canh o000
Savings 171019
Total Chocking Savings 653199
Accounts Receivable
Accounts Recebable _9300793
Total Account s Receivalie 4300783
Oahet Cutrent Assets
Employee Advances 83200
Irverdony Asset WEEY
Pre-paid Insus ance 405000
Retainage Feceivabie 30302
Undeposited Funils 244000
Total Othes Current Assets _a170840
Total Cunrent Assets 20000562
Fined Anuets
Accurmilated Depreciation A0, 344 80
Bullfings and Mg ovements 500000
Comatruction Equipnent 1530000
Furniture and Equipment 32600
Land 90,000 00

Export Report

EUM&WMhhMMMExﬁd

worksheet linking

.'-65 L o et Bogkd - Mcresoh faced
= Wome  Smet  Pagelred  Fowulm  Dats  Review Ve

i AL -2 r

IWFiAlsicioie] ¢ 5 " i 1 K L M
jzum| B 15,15 |
2 fhssirs |
1| cumemassen

4 Chocking Savings

5 Checking ansen 1

& Pemy Casn 0008

7 favegs THan

] Tetsl Checkng Savegs an

L] Accounts Urceratie

1] Accounts Becotrabl aagerey

1 Tt Rocounts Sacervitie waserm

1| Oar Currant Axsets

13 Umgioyes Advances. oo

1l wventory Avset 2080 38

15 Pro-pasd s ance e

1nf Rtarage Becoratie arerer

1 Urdepouted Fundy 244308

18} Tots Dthes Cuereea Assets T
|38 Vot Current Assets e

o) Frmed Avnets.

n Accummisten Geprecianon U

by Busdrgs and imprvements a0t 08

) Conatructon toupment e
|24 Tirrutrn and Lapspreert e300
|2 Lana 20,200 08
| 29 P a9

E ot E A ——




Click on the word Assets and type Stuff Worth @ FERLSE B Mhrnc - =

mmmml——-hmm

Money. 7"
j__hn £.DLE F -e:.‘“ [ ] 1 3 L 1]
7. The totals are formulas. Changes made to any of the 2 {sveer wosmescaey
values also change the total. ; s m;‘—;n_:- —
] Petry Cash 0000
In the Fixed Assets section, you have about g <ﬁ)
$433,218.31 in Fixed Assets. But this includes —
Arcounts Bececatie 23,007 83
furniture and equipment purchased several years i Rt T
ago for $34,326.00. Enter what the furniture and P -
nweniory Avset R
equipment is really worth today. Click in the cell s peoteum s
to the right of Furniture and Equipment and enter - mE il
$15,000. Press Enter. [ votscurmnsans mmmes
;ll'l Fromt Axnets
8. Now, you have $413,892.31 in total fixed assets. [ e tm— s
Obviously, you would not make this change to the (] et price:
Balance Sheet in the real world. ]| e
9. Useany of Excel’s features to customize this report. =
Click the Microsoft Office button and select Exit
Excel to close Excel. Click No when asked to save this -“s ) PR
= Vome  bmet  Pagelad  Fewsim  Duts  Revew  Veew
ﬁle. | Al - £l
J’ A B CDE F G H [} 1 LS L L
. AR —
1 Pro pasd Insarance 4208
W Rrtarage Arceatie amang
7 Undeposted funds. 4308
18 Tl Ottver Currend Ansets 41708 &3
1» Total Curtent Assets. 200062
: '—ﬂ:‘:ﬂ";m 110 344 69
n Durdtres and Irgumerments D00
B e mn
F-] Lana 90,000 00
- o)
» Other Axsets
tl Arcunty Deposts Atrld
» Tots Cber As ety 1720 08
| 31 ToTAL ASHTS | srsroray
| 92 st s & douTy
[ E—r—
| Actunts Paystie
|2 Accounts Paystie ety
| Tt Acoounts Paystie T
maem | sheet] ) .
=

Excel = Auto Outline feature

) m TR EJ s sotey ook 9
10. Excel has an advanced feature called Auto Outline = OO v tect toisns =T
258PM Rock Castle Construction

that helps when you collapse and expand reports. 121515 Balance Sheet
While in QuickBooks, scroll down the Balance Asniiae PariDreembrcti i

* Dec 15,15 .
Sheet you ran in the last exercise to the Payroll

Liabilities section. Suppose you want to collapse
Payroll Liability sub-accounts, but you don’t want to
collapse other sub-accounts in the spreadsheet.

Click the Collapse button. QuickBooks collapses ALL
subaccounts on the report.

11. Click Expand. Microsoft Excel let’s you choose which
accounts to collapse. Click the Export button.
Loan - Fusnitur & Office Equip 21.000.00
12. Send the report to a new Excel workbook. Lomm . Vattas @ickep Trueh) 241,00
Loan - Vehicles (Utility Truck) 193359
Loan - Vehicles (Van) 10,501 47
Mortgage - Office Building 626300
Hote Payalile - Bank of Anyeity 25930
Total Long Term Lisbilties 386968 91
Total Liabilties 42044273 &
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13. Click the Advanced tab.

14. Click the box to activate the Auto Outline option.

15. Click Export.

16. Now you're in Microsoft Excel. Use the “minus”

17.

buttons to collapse accounts.

Click the minus button next to Checking/Savings to
collapse the accounts.

Checking/Savings is now collapsed without
affecting the rest of the report

Click the “plus” symbol next to Checking /Savings to
expand the section.

Export Report 3]
Basic Agvam:ecm
Preserve the following QuickBooks report Formatting options:
i [ space between columns
Colors Row height
Turn on the Following Excel features For this report:
AutoFit (set column width to display all data)
Freeze panes (keep headers and labels visible)
how Gridline
[[] Auto Filtering (allows custom data Filtering)
Printing options
(®) send header to Page Setup in Excel
(O send header to screen in Excel
Repeat row labels on each page
L Export ] [ Cancel ] [ Help ]
FeS il et & [T —— Eae
| g""" buot  Peploet  Ferim  Oste  Reies  Vew $-nx
,m;s!;q‘_'_l_lii.ac plell F 'hf;“ M ] Liilask
Y e
5 Chechongy 45,508 10
L] Peary Canh L1
| 7 Ly AT RS T
- [] Total Chockeg Lavngs asnn
L] Actourts Recervatie
110 Arcounts Urcrevatie | sers
- 1 Tiotal Alidnants Beservatoe nwre
12 Cthas Current Avsein
n Impioyee Advances e
" entary Avset WD W
15 Pre paed st ance Amaoe
1] Brtarage Recevatie e
7 undeposted funds susee
= 5T Totsl Other Curren Assets e
=l 19 Tetsl Corven Asets e
20 tand Anasts
n Acrurmudsted Drprecuston 11034880
n Busihngs and Impreverments. AWL00800
n Commtructon gupmend 1930000
M Fusrehse and [guprmen 340800
- ~a[-:’ st b+ A

Rty

==kl e e Becit - Marssoh fsced

)
Vome  bmed  Pagelumed  Fewue  Duts  Revies  Veew

| Al =
e[ ISIS [ EAIA € D E] ¥ ) M 1 i K
| Bee 15,15
3 AT
2]
+ [ (Fotal Chocking tavings ]
: El [T —
. 0 Actonnts Recesvatie e
= 1 Total Actounts Beceeratie w1007 83
J 1 Other Cusrrent Axsets
i n Employes Advances s
Tl ieverdary Avet 260338
N T oo g nwurance amase
. 'y rtange trcomatie ime
. 17 entepnte s Tt
= 1 Total Othurr Currer Assets e
i 15 Tots Currert Ansets mome
i 20 Toed Assets
- oY Aetumnted Deorecmmen 103480
. F-] Busieng o Wprereern 2800850
. n Comatrinon | gupment 1830850
. u Fuamtire and taspment e
- F3 Land ma
. * Verwcies
. 7 Vetscies - Oeher s
= n Totsl Veties 7RI
= I Tet Fed Anvetn mzun
ILE
e D Gk Eper T ] Sheetl e .
el




18. The buttons in the upper left labeled 1 to 6 are the
Excel outline symbols.

Click the “1” button to display a fully collapsed report :
showing only Total Assets and Total Liabilities & sl e .
Equity : ::':lh 1!.:::
[} Totsl Chactany avngs. eI
19. Click the “2” button to see more detail on the report ] T —
81} oounts Becevabie mere
20. You can click 3-5 to see even more detail. Click the :: e
“6” button to display all the detail on the report. T i
15 Pre-paid Insurance amase
21. Click the Microsoft Office button and select Exit | f§ tocumirom ien
Excel to close Excel again. Click No when asked to L Hpe—— ]
save this file. | 1| R T,
ni: ] Actumissied Crpruton 11034080
= 2 Buichngs and Imprevements. 200000
- a Comtructon Egupment 1830600
| . el Fusrature and Egugement Mxe00
: ) Land 00800
b [ i T el —
==
@T‘.‘ - . Bock - Mroaoh facel 22|
= bome et Palnea Feomdm Dta  Revies  Vew -7 x
'l:' 2 i ' A E e it 1 1 [ L M M o [ 5

Excel — Auto Filter feature
rem | ) sty Dotk -
i A Rock Castle Construction
22. Excel has report filters that are sometimes faster e ool
and easier to use than the QuickBooks filters. To U PO .55 N
see how these filters work, open a report. Click the (o oot oy A e v
Reports menu and select Accountant & Taxes > :":' :ﬁz -';;7, E*“—, ".:.,..f"'..;.:;. er. ¢
. . Check 120001 8 Express Dubvary 5 Crecing 4
Transaction List by Date. s Hoke) WSt oot
Toviace ANSHNY WO Echer s Or Aoioarty Faceren tarw o
. . e ey wn Bt Chen Garag Accourts fecercs  Perodel
23. The Transaction List by Date report shows all e i Accartspaceo s
rovace REUES B Echar Depagne O Acosty Beceren Hew O
. . L] e | U Dt Acoourts Puysbie
transactions entered for a specific date range. e Ty @ T Buteess s trecarg v
L 12e0Gn  W0) Fution Harderare 5. Acoourts Parstie
Change the date range. Click the Dates drop-down o s wes ot ot
L] 12N W0 Davshors Water Actourts Furstie
list and select All. b popee it vopll oo i ol v S i
prsoirpensoriiptisvois b wapli i B byl o
24. Click the Export button to send the report to Excel. il irie it vl voberH oy il sl
promeii<iveis il o o o il o R o
25. Choose to send the report to a new Excel workbook. bassaszs :E:: g ool ciosoralenandmspin @i ;
<

26. Click the Advanced tab.
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27. Click the box next to Auto Outline to turn this
feature off. This is the feature you learned about
in the previous exercise. Then click the box next to
Auto Filtering to turn on the Excel filters.

28. Click Export.

29. Thereport is now in Microsoft Excel. Notice that
each column has a drop-down list. This indicates
that a filter is available for that column.

Suppose you only want to see transactions that
include Vu Contracting. First, click the Name drop-
down list and click the box next to Select ALL to
clear the filter.

30. Scroll down, and select Vu Contracting.

31. Click OK.

Export Report

Basic

[ Advanced ]

Preserve the following QuickBooks report Formatting options:

Fonts
Colors

[[] space between columns
Row height

Turn on the Following Excel features for this report:
AutoFit (set column width to display all data)
Freeze panes (keep headers and labels visible)
Show Gridiines
[[] Auto Outline (allows collapsing { expanding)

#uto Filtering (allows custom data ﬁll:erhg@

Printing options
(%) send header to Page Setup in Excel
() Send header to screen in Excel
Repeat row labels on each page

l Export ] [ Cancel
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32. Now, Excel displays only transactions for that name. ey} ¥

Apply another filter. Suppose you're only interested
in checks written to Vu Contracting. Click the Type
drop-down list. Then click the box next to Select All
to clear the filter. Select Check.
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34. You see the result of the new filter immediately. The @
report shows all checks for Vu Contracting.

35. Click the Microsoft Office button and select Exit
Excel to close Excel again. Click No when asked to
save this file. Microsoft Excel is a powerful program.
Use its features to enhance the reporting capabilities
of QuickBooks.
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Practice Exam
Questions

Try out these practice questions
to get a feel for the types of
questions on the QuickBooks
Certified User exam. Please

note that your performance
here does not indicate how
you will do on the actual exam.
To fully prepare for the exam,
closely review the topic areas
and objectives.
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QuickBooks Setup
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You’ve been hired by a company that
started in 1911. They’ve never used
QuickBooks. During the EasyStep
Interview, what “Start Date” should
you use?

There is no Start Date in the EasyStep Interview.

The date the company bought QuickBooks.

1911

The date you want to begin tracking the company’s
finances in QuickBooks.

Correct answer: d

b.
C.

d.

When setting up a new company
through the EasyStep Interview,
some company information is
optional and some is absolutely
required. Which of the following
pieces of information does
QuickBooks require you to enter?

Company name
Company password
Tax ID

All of the above

Correct answer: a

© © 0600000000000 000000000000000000 00 00

QuickBooks Utilities
and General Product

Knowledge

3. Which of the following is NOT a
backup option in QuickBooks?

a.  Manually back up the file.

b.  Automatically back up the data file when closing
QuickBooks.

c.  Schedule an unattended backup

d. Allof the above are QuickBooks backup options.

Correct answer: d

If you choose to “Remove
Transactions as of a specific date”
from the “Clean Up Company Data”
window, what does QuickBooks do?
Removes all payroll transactions that occurred on

that date. This is a great way to fix the mistakes a
new person made on a particular day.

Removes all transactions while leaving lists,
preferences, and service subscriptions intact.

Changes the company’s start date.

Deletes all transactions, as well as user passwords
and access privileges.

Correct answer: b
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List Management
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5.

What do the diamonds mean
on certain lists (for example, the
diamonds to the left of each
Customer:Job)?

You are not allowed to delete that entry.

You can click on the diamond and move the list entry
to a different location on the list.

There are open transactions related to the list entry.

You cannot move the list entry.

Correct answer: b

What is the maximum number of
names that can be included on the
Names lists in QuickBooks Pro or
Premier?

10,000
1,000
2,500
14,500

Correct answer: d

© © ¢ 0 0 0 00 0 0000000000000 000000000 00000000000 0000000000000 000000000000 0000000000000 000000000 O

31



© © 0600000000000 000000000000000000 00 00

Items
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7. What item type should you use for
inventory that you assemble from
other items and then sell?

a. Group

b.  Inventory Part

c.  Inventory Assembly
d. Non-inventory Part

Correct answer: ¢

8. Which of the following statements is
true concerning items?

a. You can use one item to represent different services
or goods.

b.  Items allow you to track your sales in more detail
without cluttering your Chart of Accounts or Profit &
Loss.

c.  Tocreate an invoice, you must use an item.
d. Allof the above.

Correct answer: d
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List Management
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9. When should you create an invoice in
QuickBooks?

a.  When a customer purchases goods or services and
pays you in cash at the time of the sale

b.  When a customer purchases goods or services and
pays you by check or credit card at the time of the
sale

c.  When a customer purchases goods or services, but
you don’t want to record the sale as final

d.  When a customer purchases goods or services but
does not pay you at the time of the sale

Correct answer: d
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10. When should you use a Sales Receipt
in QuickBooks?

a. To give a customer a receipt for payment of an
invoice

b. Torecord a customer prepayment or deposit
c. Torecord a customer payment at the time of sale
d. To enter a customer early-payment discount

Correct answer: ¢
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Purchases
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11. How do you track accounts payable
in QuickBooks?

a. Enter abill, and then use the Write Checks window.

b.  Write a check, and then mark it as “pending” until
you pay it.

c.  Enter abill, and then use the Pay Bills window.

d. You can't track accounts payable.

Correct answer: ¢

12. What transaction/form do you begin
with to enter a vendor credit?

a. Vendor Credit

b.  EnterBill

c.  Pay Bills window

d. Receive Vendor Credit

Correct answer: b
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Payroll
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13. When printing paychecks, what is
the preferred check style to give an
employee a paystub?

a. Standard
b.  Wallet

c.  Payroll

d.  Voucher

Correct answer: d

14. When setting up a new employee,
what is important about the Payroll
Info tab?

a.  Whatever you enter/see in this window affects each
paycheck, unless you change the information on the
paycheck itself.

b.  Itidentifies the state subject to withholding and the
state where the employee lives (usually the same).

c.  You enter Emergency Contact information, which is
required by law in many states.

d.  This tab tracks an employee’s age and gender
necessary for tax calculations.

Correct answer: a
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Reports
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15. How do you create a memorized
group of reports?

a. Click the Report Center icon. Then click the Create
New Report Group button.

b. Open the Memorized Report List and then click
Memorized Report > New Group.

c.  Choose File > Reports > Memorized Reports >
Create Group.

d. Open the Group Reports List and then click Groups >
New Group.

Correct Answer: b
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16. What is the purpose of
subaccounts?

a. Track departments or locations efficiently

b.  Track finances in more detail by grouping accounts
in a logical fashion and showing a subtotal for those
accounts

c.  Toshow different Account Types together in one
section of areport

d. None of the above

Correct answer: b
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Basic Accounting
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17. When you run Financial Statements
in QuickBooks, what bookkeeping
basis can you use to view the report?

a. Cash Basis.

b.  Accrual Basis.

c.  You can switch the bookkeeping basis if you want.
d.  Allof the above.

Correct answer: d

18. What are the 2 main Financial
Statements you can run from the
“Company and Financial” category
of reports?

a. Balance Sheet, Profit and Loss
b.  Balance Sheet, Statement of Operations
c.  Profitand Loss, Statement of Operations

d. Statement of Operations, Statement of Financial
Position

Correct answer: a
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Customization/Saving Time
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19. Suppose your address information
appears on the upper left of your
invoice and you want to move it to
the lower right. How would you do
this?

a. Use the QuickBooks Print Engine Editor

b.  Use the Layout Designer

c.  Openthe Financial Statement Designer

d.  Use the Custom Form Designer

Correct answer: b

20.You need to enter the same
transaction each month (for
example, an insurance payment).
How can you automate this process
in QuickBooks?

a.  While the transaction is on the screen, choose Edit >
Memorize check (or the name of the transaction).

b. Choose File > Automate Transactions and use
the wizard to set up the automated checks or other
transactions.

c.  From Preferences, choose General and click Set Up
Automated Transactions.

d.  While the transaction is on the screen, click the
Recur button.

Correct answer: a
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Notes

© © 0 0 0 0 000000 00000000 0000000000000 0000000 0000000000000 0000000000000 0000000000000 0000000 00 o

© © ¢ 0 0 0 00 0 0000000000000 000000000 00000000000 0000000000000 000000000000 0000000000000 000000000 O

35



CERTVPORT®

© Copyright 2011 Certiport, Inc.

Certiport and logo are registered trademarks of Certiport,
Inc. Intuit is a registered trademark of Intuit, Inc,, in the
USA and other countries.

QuickBooks Certification available in the U.S. only.



